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Abstract: 

The purpose for this thesis is to investigate the mechanical properties of the 

aluminium foil used for packaging industry, the reaction of the material 

exposed to loading and the crack sensitivity coupled to the maximum strain 

in the material after loading. This investigation will be based on both 

physical experiments and numerical simulations in the Finite Element 

Method program ABAQUS for with and without initial crack of different 

length. The simulations purpose is to get a better understanding of the 

different material parameters and the physical tests serves to verify the 

numerical model and to prove its credibility. The final model in ABAQUS 

will be used to test the parameters in an extensive parameter study with the 

ambition to find an ultimate combination of the parameters both for the 

material and its adhesion with LDPE. 

Keywords: ABAQUS, Adhesion, Finite Element Methods, Numerical 

Simulation, LDPE. 
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1 Notations 

  Applied Force 

            Correction Factor 

  Crack Length 

      Crack Tip Opening Displacement 

  Elasticity Modulus 

G          Energy Release Rate 

  Length  

  Poisson Ratio  

           Strain 

KI         Stress Intensity Factor 

  Thickness 

  Width  

           Yeild Stress 
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2 Introduction 

Tetra Pak is the world leader in food processing and packaging solutions. 

They provide safe and innovative packages for millions of peoples every 

day. Tetra Pak was founded by Ruben Rausing in Lund in the 1950’s and 

his idea of tetrahedron shaped cartons for milk was born. Today Tetra Pak 

is located in more than 170 countries worldwide. 

Polymer mainly use for liquid food packages, consists of various polymer 

films which are bonded together using adhesion or by a direct heat. The 

consisting materials are made from Low-density polyethylene (LDPE) and 

Aluminium (Al). 

The theory provides easiness and competence for designing a component 

for static and dynamic loading and also prevents failures of structural and 

mechanical components subject to fluctuating loads .Different loadings 

occur at a time during transportation that cause opening phenomena of food 

packages. Linear elastic fracture mechanic (LEFM), Elastic Plastic Fracture 

Mechanics (EPFM) and Modified Strip Yield Model theories helped 

analyzing effect while loading components, response and fracture of 

material. 

Thesis Fracture Toughness Analysis of Aluminium Foil and its Adhesion 

with LDPE for Packaging .Basic idea behind the thesis is to define Finite 

Element Modelling strategy and experimental test procedure so that 

materials properties like fracture toughness damage initiation, damage 

evolution, and adhesion between different packaging materials. The two 

types of test are Physical test and virtual test in the computer software 

ABAQUS and compared. Mode I tensile test is performed on Aluminium, 

LDPE and Aluminium laminated with LDPE. Calculation of fracture 

toughness and parameters of Al and LDPE were done by Physical test 

results. 
To understand the material and it different parts the goal is to build a 

numerical crack model in ABAQUS. The model is based on several layers 

of material that are assembled with cohesive zones between them. The 

cohesive zones purpose is to simulate the adhesion between the layers. To 

get cohesive zones which coincides with reality several, ordinary and some 

customized, adhesion tests has been carried out. 

The crack initiation and propagation are simulated with the Finite Element 
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Method and Linear Fracture Mechanics. The ambition is to first build a 

simplified model with less material layers and only uniaxial simulation and 

to progress gradually when simulation and material behaviour are verified. 

The thesis will hopefully lead to further understanding of each of the 

laminates parts and how they contribute to crack development in the 

laminate. The difference in material behaviour adhesion and cohesion will 

also be investigated to gain further material understanding. 
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3 Theoretical Model 

3.1 Theory of Fracture Mechanics 

The basics of Fracture Mechanics were used to study the breakage 

behaviour of different materials. The material property to resist breakage 

and failure is also described by this basic study [3]. 

Fracture Mechanics is the theory of the cracks contained by the materials 

and structures; it deals with the initiation and the propagation of the crack. 

There are three different basic modes of loading on a crack tip [5]. All the 

three modes have different stress intensity factor at the crack, which is 

required to propagate the crack [3]. 

Mode I: In Mode I, the forces applied are normal to the Crack surface. The 

crack will be opened by the normal force [3]. 

                               (3.1) 

 

 
Figure 3.1a [6] 
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Mode II: Forces applied on the crack are parallel to the plane, in mode II, 

which will make or propagate a crack by sliding one another (Figure 3.1b). 

                                        (3.2) 

 

 

 
 

Figure 3.1b [6] 

Mode III: Applied force is normal to the crack propagation, in this mode 

III, or defined as shear out of plane (Figure 3.1c). 

                                    (3.3) 
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Figure 3.1c [6] 

 

3.2 Material Properties (Al and LDPE) 

The materials physical properties often depend on its direction or plane 

[7].The Machine Direction (MD) is described as the direction in which the 

manufactured material is rolled while the direction perpendicular to 

machine direction is Cross Direction (CD). If any material has same 

physical properties in both directions, it is known as isotropic material. 

In the case of Aluminium and LDPE both materials are isotropic because 

their properties remain same in all directions. The laminate in this work 

consists of Al-foil/Adhesive/LDPE. LDPE is in reality not linear, but at 

small strains it can be approximated with a linear elastic material. It can 

also be considered to be isotropic. The adhesive layer is assumed to have 

the same mechanical properties as LDPE [20, 21]. 

 10 

 

Figure 3.1c: Crack loaded in Mode III [8] . 

 

3.2 Material properties 

Materials often have physical characteristics that depend on the plane or 

direction [15]. Figure 4.1 shows direction of material in manufacturing. 

MD (Machine direction) is the direction the manufactured material rolled 

and CD (cross direction) is the direction perpendicular to the MD. 

Isotropic and Anisotropic materials: 

When the properties of a material are the same in all directions, the material 

is said to be Isotropic. When the properties of a material vary with different 

orientation, the material is said to be anisotropic. 

 

Figure 3.2: Directions of a material in manufacturing. 
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3.3 Theory of Linear Elastic fracture Mechanics 

(LEFM) 

Linear Elastic fracture Mechanics material is Isotropic and linearly elastic. 

By help of these assumptions and the theory of elasticity, stress field near to 

the crack tip is calculated [5]. The stress field near crack tip depends 

directly on the geometry of the specimen location and the applied loading. 

The location is denoted by r‘and θ’ as polar coordinate system whereas 

loading and geometry are submitted as single parameter KI called stress 

intensity factor. 

Stresses at crack region, using LEFM explains as follows [8]: 

    
 

    
                            (3.4) 

Here 

r= Distance from Crack Tip 

θ = Angle of crack Plane. 

K = Stress Intensity Factor. 

Where “i” and “j” shows Cartesian axes, also known as angular functions 

[8]. The stress intensity factor “K” becomes equal to the fracture toughness 

at start of crack growth. 

The LEFM limiting stress is mathematically expressed as: 

   
  

     
                     (3.5)      

Here above notation are described as 

a =Half of crack length. 

σ = Stress at Crack Growth. (Obtained from experiments). 

Kc = Fracture Toughness. 

When inelastic deformation is small compared to the crack size the LEFM 

theory is valid which is called as small scale yielding (SSY) [9]. Both 

energy and stress intensity approaches to linear elastic mechanics are 

described below. 
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3.4 Criteria for Design  

The energy criterion and the stress intensity approach are the two 

approaches to the fracture analysis, as discussed below. 

The energy criterion 

The energy criterion describes that the fracture is produced when the 

energy used for crack propagation is more than the resistance of the 

material. The surface energy, plasticity or the energy for crack propagation 

is included in the material resistance [9].  

For a linear elastic material, the rate of change of potential energy with 

respect to crack area is known as Energy release rate. The energy release 

rate “G” for a given crack length 2a (2a<<Width) under a tensile stress, can 

be defined as; 

  
    

 
             (3.6) 

Where In above equation 

“ ” is denoted as the applied stress,  

“a” is the denoted as the half  of crack length and 

“E” is denoted as the Young’s modulus. 

The energy, at the time of fracture occurrence is known as critical energy 

release rate, G=Gc, which defines the fracture toughness of material. The 

combination of stress and critical crack size during fracture, is described by 

the equation (3.7)  

   
     

   

 
                (3.7) 

The energy release rate G can be termed as the driving force for fracture, 

the critical energy release rate Gc is the materials resistance to fracture. 

The basic assumption is that the critical energy release rate Gc does not 

depend on the size and geometry of the cracked material. This assumption 

of fracture mechanics is applicable until the material shows predominantly 

linear elastic behaviour [9]. 

The Stress Intensity Approach 

The stress state near the crack tip is examined by the stress intensity 

approach. These stresses are directly proportional to a stress-intensity factor 
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(KI) which in linear elastic material expressed as crack tip characteristic. 

Where the “I” denotes the crack opening mode as described in section 3.1. 

Fracture is an alternative measure of fracture toughness and propagates at 

critical stress intensity KIC [8]. 

The stress intensity factor for an infinite plate is given by 

                                          (3.8) 

 

3.5 Elastic-Plastic Behaviour 

Elastic-Plastic Fracture Mechanics theory is applied to those materials that 

are independent of time and plastic deformation. There are two parameters 

of elastic-plastic that describes crack tip conditions in elastic-plastic 

materials and those are J-Contour Integral and crack tip opening 

displacement (CTOD). 

Crack-Tip-Opening Displacement (CTOD) 

According to Wells, before the fracture, the crack faces had moved apart 

and an initial sharp crack was blunted by plastic deformation. The angle of 

crack blunting increases with proportion to the material toughness. Wells 

proposed the opening at the crack tip based on this theory, parameter is 

known as CTOD that is a measure of fracture toughness [11]. 

Commonly used two types are the displacement of the original crack tip 

and 90
0
intercept. Rice also suggested CTOD in 90

0
 intercept used in finite 

element measurements [12]. 

 

3.6 Propagation of Crack 

When the materials resistance to the load reaches its peak and the stress 

intensity factor KI reaches a critical value KC, the crack starts to propagate 

in a specimen, this critical value is known as fracture toughness. Therefore, 

the crack propagation will start, when; 

KI KC 

The crack propagation can be expressed in terms of energy. The stored 

strain energy is used by the crack for the propagation and to produce new 
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crack surface in the material. Therefore, stored energy in the material is 

required to create the new crack surface otherwise there will be no crack 

propagation. The below condition should be fulfilled for crack propagation, 

as the required energy for a crack to grow is “G” and material resistance to 

crack propagation is “R”, 

G=R 

As soon as stored energy becomes equal to material resistance, the crack 

starts growing. If the stored energy is less than the material resistance, there 

will be no crack propagation and if the stored energy is greater than the 

material resistance, thus the Material or structure failure develops causes 

unstable crack continue [5]. 

 

3.7 Model of Modified Strip Yield 

Model of strip yield for a crack, using two elastic solutions given below, 

defines the elastic plastic behaviour: 

1. Crack under remote tension. 

2. Crack with closure stress at the tip. 

The discontinuous displacement segment was assumed to model the strip 

yield plastic zone. The initial crack length including the discontinuous 

displacement segment length is 2(a+l), where “l” is the length at each end 

of discontinuity is under equal stress σb and 2a is a crack length and length 

“l” are the plastic zone represented by non linear behaviour of material.  

[13], [14] 

For calculating the yielding in thin steel sheets, Dug dale suggested the 

strip yield model and later this model was used for variety of materials. The 

strip yield model is applicable to polymer materials. This can be shown in 

figure 3.2 [13], [14], [16]. 

The below equations give the crack tip opening displacement (δCTOD) and 

cohesive zone length of a large sheet at start of crack propagation [17]: 

       
 

  
          

   

   
               (3.9) 

And 

         
   

   
  -1

-1]          (3.10) 
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where, σc is denoted as uniaxial stress that is perpendicular to the crack 

surface having large distance. The following equation will be obtained by 

principle of virtual work: 

        
  
 

 
         (3.11) 

The relation between applied stress and crack length can be derived from 

above equations (3.9) and (3.11), as written below; 

  

  
 

 

 
            

   
 

    
              (3.12) 

Equations (3.9), (3.10) and (3.12) are derived for infinite plates. For 

reasonable results of finite plate the correction factor   from (3.15) is used 

to redefine (3.12), when a → W, is given by; 

  

  
 

 

 
            

   
 

      
            (3.13) 

 

Figure 3.2. The strip yield model [20]. 

3.8 Fracture Toughness 

Ability of a material containing a crack to resist fracture is known as 

fracture toughness [18]. Fracture toughness is not linked with the size and 

geometry of cracked body [9].  Fracture toughness and its behaviour of 

crack propagation mainly depend on the material’s thickness [8]. 

The different values of KI will be produced for the specimens having 

different absolute size and standard proportions. It happens because of the 

stress for specimen thickness varies and it continuous until the thickness 

exceeds some critical dimension. After this KI becomes relatively constant 
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and this material property is known as the plane-strain fracture toughness 

“KIC” [19]. 

The load corresponding to define unstable crack propagation helps to 

compute fracture toughness. The stress intensity factor, K, is equals the 

fracture toughness during the crack propagation. The stress for LEFM is 

given by [8]. 

           
 

 
               (3.14)  

Where in above expression 

    Defines remote applied stress, 

   Defines correction factor for sample [8], 

a defines half crack length, 

W defines half width.  

The correction factor   for sample is 

  
 

 
   

        
  

 
       

 

 
 
 

   
 
  

  
 
 
 

 
 

           (3.15) 

The relationship of stress vs crack length is given by [8] 

     
    

   
              (3.16) 

 

 

Figure 3.3: Specimen Dimensions [1]. 
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(3.19) 

 

Here, is the remotely applied stress,  is a geometrical correction factor 

for center crack specimen [1], a is half crack length, W is the half specimen 

width. The geometrical correction factor  for center crack specimen is 

 

 

(3.20) 

Analytically, relationship of experimental stress versus crack length is 

given by [1] 

 

 

(3.21) 

 

 

 

  

 

 

 

 

 

 

 

 

 

 2h = L B 

 

 

 

 

 

 

 

2W 

Figure 3.11: Specimen configuration with a centered crack of length 2a 
[1] . 

 

 

           2a 
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3.9 Adhesion Behaviour 

Bonding at an interface between the adhesive and adherent is due to 

adhesion in a simple system. When a measurable amount of mechanical 

work is required to separate two surfaces of different chemical composition 

or shape then the adhesion is taken in account [23, 24]. Good molecular 

contact is required in order to get good adhesion between adherent and 

adhesive. The maximum force required to break the bond is defined, as a 

measure of adhesion and the measure of the strength of an adhesive bond 

across an interface is the amount of energy needed to break it, i.e., to 

separate two surfaces. Such a separation may involve the breakage of 

chemical or van der Waals bonds, and the plastic deformation of one or 

both of the materials on either side of the interface. The fraction of energy 

required to break the bonds at the interface is a very small fraction of the 

total energy necessary for the separation of the two surfaces in all cases 

where good adhesion is present. Most of the mechanical work is used to 

deform, under stress, the material adjacent to the interface. Therefore, the 

measured energy of adhesion will be dependent on the ability of the 

interfacial bonds to sustain stress, as well as on the amount of plastic 

deformation caused by the above-mentioned stress [24, 25]. 

In many structures the use of adhesives is common. To explain the adhesive 

behaviour separation law can be used. max is the maximum stress (Damage 

Initiation in ABAQUS) that the adhesive can take and δmax(Damage 

Evolution in ABAQUS) is the maximum separation of the bulk material 

before the adhesive breaks and the bulk material are fully separated.[2] 

 

3.10 Theoretical Results and Discussion 

The critical stresses for the aluminium foil with different crack lengths (5, 

10, 15, 20 and 45 mm) were calculated. By using the LEFM equation (3.5), 

Strip yield model (3.17) and the experimental results for the aluminium 

foil, the following fracture toughness graph is plotted, which show the 

normalized critical stresses versus normalized crack length: 
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Figure 3.4. Fracture toughness graph. 

 

The theoretical calculations by LEFM and strip yield model give a close 

correlation with the obtained experimental results. The fracture toughness 

KC obtained for the aluminium foil with thickness 9microns is 6.39 

MPam
1/2

. The fracture toughness KC = 6.1 MPam
1/2

 was obtained for the 

aluminium foil for thickness of 6.25 microns. [13] 
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4 Experimental Work 

4.1 Experimental Setup 

These experiments were performed to verify test procedure to describe 

material properties relating fracture initiation and propagation that 

describes opening performance under mode I and adhesion force between 

LDPE and Al foil. To calibrate material models used in the FE- simulations 

exact experimental data was needed. This policy was used for the computer 

simulation to calculate the fracture and continuum material parameters. 

After that the physical tests and virtual tests were visually compared. 

Two different types of layers of AL foil having different thickness were 

tested. Crack in center of the test specimen was made by hand using scalpel 

and steel ruler. 

The Al foil with thickness 9  m is tested. Data for LDPE with thickness 

27  m was taken from the previous year master thesis work given [1]. 

Types of test Cases 

Five different test cases were performed as follow. 

1. Al foil. 

2. Al foil/LDPE (Without adhesion). 

3. Al foil/Adh/LDPE. 

4. Peel Test. 

5. Shear Test. 

Tensile force was applied to pull specimen apart along height by applying 

load on upper griper. Force versus displacement data was obtained and 

exported for further analysis in ABAQUS. The MTS (tensile test machine) 

is provided with pair of gripper for clamping the specimen ends. In MTS 

lower clamp is stationary while by applying displacement on the crosshead 

upper one moves up accurately. 2.5 KN load cell was used due to the 

weight of the clamper. Between the grippers the specimen was placed and 

clamped specimen were loaded and extended till it breaks or to desired 

displacement. The test speed was adjusted to 10mm/ min. the distance 

between grippers were 230mm. The load and extension of the specimen 

was controlled automatically (Figure 4.1). 
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At the laboratory of Blekinge Institute of Technology (BTH) All of the 

physical tests related to thesis were performed The test results are shown in 

Appendix. 

 

 
Figure 4.1. MTS machine at BTH Lab [1]. 

 

4.2 Material Used 

Low density polyethylene (LDPE) was obtained from the circular batch 

where melted LDPE on a PET layer which was required for few tests 

(Figure 4.2). LDPE layer was extracted from PET by help of extruder. Al 

foil, Al/LDPE (without adhesion) and Al/Adh/LDPE (with adhesion) was 

supplied by Tetra Pak, Lund. Both LDPE and Aluminium were assumed to 

have isotropic behaviour in this work, as there is no difference in properties 

by changing the direction of material. 
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Figure 4.2. Extraction of LDPE from PET [1]. 

 

4.3 Sample Preparation 

Measure half width W and height h from center by help of scale. Before 

performing tests it is necessary to measure thickness of the materials and its 

layers by Micrometer because sometimes the thickness varies according to 

manufacturers demand. 

For every type of material, Al foil and laminated AL foil at least five test 

specimens of 95x230mm size were prepared (Figure 4.3). To remove effect 

of finite size specimen (2W equals to 95mm) width is assumed infinite in 

comparison with crack length. Using a steel ruler and knife made the 

specimens and cracks. For MTS machine’s gripper, height size more than 

230 mm specimen is taken. Half crack length was made from center to both 

directions in order to have similar pre-crack tip shape. While making the 

specimen of Al foil it should be taken in account that no pre crack was 

introduced, as AL foil is very sensitive to handle. 

To carryout peel and shear tests a simple paper-laminating machine was 

used to make Al foil bonded with LDPE. The thermostat of the machine 

was set between 8 and 10. To protect the materials from having direct 

contact with the heated roller, paper and PET was placed on both sides 
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using a steel ruler and knife. The crack on LDPE made before the LDPE 

specimen peeled from PET. This helps to make a perfect crack goes along 

the center line of the specimen.  

Taking gripper of MTS machine into consideration, height size greater than 

230 mm specimen is taken. Since LDPE specimen layer has been produced 

by extruding melted LDPE on PET layer with a table extruder (Figure 

4.4a), it is first pre peeled from PET in the portion of the specimen 

considered for the griper before the specimen cut. The center crack made 

half crack length from center to both directions (Figure 4.4b) in order to 

have similar pre-crack tip shape. Finally, LDPE carefully separated using 

the smooth circular rod of the table extruder from both ends (height 

direction) till the center crack region. The remaining peeling process 

around the crack region has been done carefully by hand along crack (width 

of the specimen) direction. The application of the rod has helped in 

protecting the formation of dimples on LPDE layer while peeling by hand. 

The detached face of LDPE layer showed property to stick and roll over the 

smooth circular rod. This helped to separate the two layers easily and 

slowly. 

               
Figure 4.4a: Extrusion of test size LDPE layer from PET laminated with 

LDPE layers. 

 
Figure 4.4b: Center crack cut direction of test specimen. 
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while laminating and PET helps to remove it easily without sticking to 

paper. The peel and shear areas were 230mm*70mm. 

 

 

Figure 4.3. Specimen with center crack and without center crack [1]. 

 

4.4 Running the Experiments 

When the specimens were ready the MTS machine was switched on and 

MTS Test work software was launched. Simplified tensile test was selected 

and input parameters such as SI units, Grip separation and test speed were 

adjusted to required values. 

Then the specimen was mounted between the grippers, and grippers were 

tightened by help of nuts and bolts to make sure that specimen will not slip 

out during the test. The specimen and gripper should be parallel to 

crosshead. Make sure that the load and extension were set to zero before 

running the test. Run the test by pressing play button from the handset of 

MTS machine or by clicking through software. The force versus 

displacement graph will be displayed continuously as the test starts. 
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extension set to zero before running (pressing play button) the test. As the 

test begins, the load versus extension plot displayed continuously.  

 
Figure 4.6 Configuration of specimen with center crack and without center 

crack. 
 

In the case of pre-center crack, the crack tears along the width of the 

specimen following the centerline for both layers, LDPE and BoPP. Where 

as in the case of without pre-crack, BoPP layer fail suddenly and LDPE 

may fail suddenly or may tear around the lower gripper. When the test 

ends, the display shows plots of load versus extension. As a result 

Semicolon separated row data exported and saved. The test process 

continues at least for five specimen layers.  The exported data imported to 

MATLAB for analysis. 

4.6 Laminate 

A simple paper laminating machine was used to make BoPP both side 

bonded with LDPE (Figure 4.1). The manual was studied and observed that 

the machine operate at 120 
o 

C. Paper placed on both side of the lamina to 

protect the lamina from having direct contact with the heated roller while 

laminating. A short and brief description of operating condition included in 

Appendix B. 
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In case of no pre crack the Al foil, Al/LDPE and Al/Adh/LDPE tore around 

the lower gripper or fail suddenly from the center, while in case of pre 

crack the crack moves along the width following the centerline in all cases. 

The Al/LDPE and Al/Adh/LDPE specimens with initial cracks of different 

crack lengths were stopped manually at different displacements to study the 

effect of adhesion and crack propagation behaviour through lamina. 

The peel test was performed at 180
0
(Figure 4.4(a)). Al foil was mounted on 

one side and LDPE on other side and peel area was set free and test was run 

as ran for no crack and crack having specimens. This test method identifies 

the strength of adhesion or peel ability of materials. Peel adhesion is the 

force required to remove the coated material, which has been applied to 

other material under specified conditions at a desired angle and speed [26]. 

The shear test was performed as peel test by mounting different material on 

different clamps. 

Load versus displacement graph was displayed at end of the experiment 

with was then exported and saved to test work export folder, and then 

imported to MATLAB for analysis. 

 

Figure 4.4(a). Peel Test [2].        Figure 4.4(b). The Tensile Test  

    Machine [2]. 
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4.5 Experimental Results and Discussion 

Case 1: Aluminium Foil 

As both the materials were isotropic they behaved similarly in MD and CD. 

Al foil fails suddenly or tore from lower clamp if it had no crack. So the 

behaviour of LDPE was same. When both have pre cracks the crack 

propagated along width following the centerline. 

 

Figure 4.5. Load Vs. Displacement of Al foil in MD and CD. 

 

Figure 4.6. Load Vs Displacement of Al foil (center cracked) of 0-45mm. 
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Figure 4.7. Load Vs Displacement of Al foil with center crack of 0-45mm. 

 

Table 4.1 Load and displacement of fractured Al foil, thickness B of     

and dimensions of 230*95mm. 

Crack Length (2a) 

mm 

Maximum Load (F) 

N 

Extension 

mm 

No Crack 61.45 3.218 

5 mm 44.64 0.606 

10 mm 38.62 0.523 

15 mm 34.99 0.458 

20 mm 25.88 0.38 

45 mm 14.47 0.16 
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Case 2: Aluminium foil/LDPE (without adhesion) 

When Al/LDPE without adhesion was tested the Al foil broke quicker than 

the LDPE. So LDPE took more time to fail than Al foil.  It is because of 

ductility of LDPE. 

 

Figure 4.8. Load Vs Displacement of Al foil/LDPE with center crack of 0-

20mm. 

Table 4.2 Load and displacement of fractured Al foil/LDPE, thickness B of 

     and dimensions of 230*95mm. 

Crack Length (2a) 

mm 

Maximum Load (F) 

N 

Extension 

mm 

No Crack 53.8 7.553 

5 mm 50.46 3.792 

10 mm 40.26 2.7 

15 mm 42.51 3.666 

20 mm 31.1 2.6 
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Case 3: Aluminium foil/Adh/ LDPE (with adhesion) 

When Al/Adh/LDPE was tested, both materials failed at same time this is 

because of strong adhesion force between them and hence they act as one 

material. 

 

Figure 4.9. Load Vs Displacement of Al foil/Adh/LDPE for 0-20mm    

(center cracked). 

Table 4.3. Load and displacement of fractured Al foil/Adh/LDPE, thickness 

B of      and dimensions of 230*95mm. 

Crack Length (2a) 

“mm” 

Maximum Load 

(F)“N” 

Extension “mm” 

No Crack 44.61 4.756 

5 mm 38.04 1.653 

10 mm 30.07 0.863 

15 mm 28.24 0.334 

20 mm 23.59 0.653 

 

  



 27 

Comparison between Case 2 and Case 3 

In case 2 the aluminium breaks before the failure of LDPE as in (figure 

4.10 a) this because of the ductility of LDPE. As shown in graph the 

aluminium breaks before 6mm and LDPE survive failure until 20mm. 

While in case 3 due to strong adhesive bonding between the materials, they 

act as one and both breaks at the same point as in (figure 4.10 b). 

 

Figure 4.10a. Load Vs Displacement of Al foil/LDPE for 0-20mm       

(center cracked).  

 

Figure 4.10b. Load Vs Displacement of Al foil/Adh/LDPE for 0-20mm 

(center cracked). 
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Case 4: Peel Test 

While performing peel test it was noticed that the much less force was 

required than the tensile force, to peel off the materials from each other. As 

shown in (figure 4.11) the peeling force was almost ten times less than the 

tensile force shown in (figure 4.10). The results may not be satisfactory 

because of hot material from the lamination machine, self-lamination 

(human error), and less area of specimen (230*70mm). 

 

 

 

Figure 4.11. Load Vs Displacement graph of Al foil/LDPE 180
0
Peel Test. 
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Case 5: Shear Test 

When test was performed in the shear direction the Al foil did break before 

the adhesion layer got damaged. In the normal direction LDPE laminated 

and Al foil broke instead of the adhesion layer did break. With this insight a 

factor of five (5) was determined. The adhesion in the shear direction was 

set to be ten times stronger than in the normal direction. This relation is 

used when the cohesive surfaces is implemented in ABAQUS [2]. The 

results may not be correct because the material was laminated by 

lamination machine in BTH Lab, pre crack in aluminium and change of 

material properties due to heating. 

 

 

 

Figure 4.12. Load Vs Displacement graph of Al foil/LDPE Shear Test. 
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5 Numerical Tests (ABAQUS) 

ABAQUS is a Finite Element Method program based on deformation, 

consisting of different modules and solution techniques. To have clear 

understanding of the material behaviour and properties, virtually exact 

same tensile tests are performed. ABAQUS 6.10 was used to do the virtual 

test. To create a model in ABAQUS one follows three stages. The first 

stage, pre-processing, is to create a geometric model in ABAQUS/CAE, 

this module is similar to a CAD program. In the second stage the pre-

processing file is sent to the solver, the ABAQUS/Explicit using an explicit 

solver. In the third stage the results is published in files ready to be post 

processed. . For tensile test all modelling techniques like modelling fracture 

in ABAQUS 6.10 are described in Appendix. 

Assumptions 

Following assumptions are made to conduct numerical tests in ABAQUS 

6.10: 

 As the thickness is less Plane stress was considered.  

 Shell elements were considered 

 For polymers Non-linear elastic plastic fracture material model were 

considered. 

Modelling Procedure 

Following modelling procedure was used to conduct the tensile test in 

ABAQUS 6.10/Explicit: 

 

 Calibration of continuum material parameters. 

 Calibration of fracture material parameters.  

 

5.1 Material Parameters Calibration 

To model the tensile test for aluminium foil and LDPE in ABAQUS, the 

material properties are required. To calibrate the data for numerical 

simulation, experimental results are required. The (figure 5.1) shows the 

force versus displacement graph for aluminium foil with no crack. The blue 

plot was selected to calibrate the properties of material. 
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Young’s Modulus (E) 

 For material elasticity limit, Young’s Modulus is defined as the ratio of 

uniaxial stress to the strain  

  
 

 
                      (5.1) 

First of all young’s modulus was calculated by producing the stress versus 

strain plot from the experimental result as shown in (figure 5.1). Then the 

young’s modulus will be calculated using the formula equation (5.1). 

 

Figure 5.1. Stress Vs. Strain Graph. 

 

Plasticity 

For the deformation modelling in ABAQUS, the true stress and the 

logarithmic strain measure are used as default. It can be shown that stress 

vs. strain plots, which use logarithmic strain and true stresses, coincide 

approximately with test results. True stress is also a measure that can be 

used for practical interest compared to other stress measurements [10]. 
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The true stress defined as 

                                          (5.2) 

True Strain can be expressed as 

                                           (5.3) 

 

 

Figure 5.2. Normal stress-Strain behaviour of an elastic-plastic material in 

tensile test [22]. 

It is a behaviour of material beyond the elastic limit, which can be obtained 

by plotting true stress versus true strain and then used in ABAQUS instead 

of nominal stress and strain values. 

True plastic Strain defined as 

                     
     

 
            (5.4) 

Plasticity was calculated after young’s modulus. Plasticity is a behaviour of 

material beyond the elastic limit, which can be obtained by plotting true 

stress versus true strain. The true stress and true strain can be calculated 

from equation (5.2-5.4). Then the plot obtained from the true stress versus 

true strain is 
 42 

The true stress and strain (Figure 5.2) expressed as 

  (5.4) 

 

  (5.5) 

These relationships are valid only prior to necking. 

True plastic strain expressed as  

 

 

(5.6) 

 

 

Figure 5.2: True stress-plastic strain. 

 

5.2 Calibration of fracture material parameters 

Components of material definitions: 

 The material behavior under no damage. 

 The material behavior under damage (damage initiation (point A)) 
[Figure 5.3]. 
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Figure 5.3. True Stress Vs. True Strain Graph. 

 

5.2 Fracture Material Parameters Calibration 

Following are the components to define material; 

 The behaviour of material under no damage. 

 The behaviour of material under damage (damage initiation (point 

D=0)) [Figure 5.4]. 

 The behaviour of material after damage initiation (damage evolution 

(D=0 to   
  

)) [Figure 5.4]. 

Damage initiation 

It defines the point at which degradation of stiffness starts [27]. Fracture in 

a ductile polymer can be caused by two main processes; 

 Nucleation, growth, and coalescence of voids causes ductile fracture 
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 Shear band localization causes shear fracture.  

The behaviour of damage growth depends on these above two observations 

[22]. 

Ductile damage 

In ductile metals, the damage caused by nucleation, growth, and 

coalescence of voids can be predicted by the initiation criterion model. The 

assumption made in this model is that the plastic strain is function of stress 

triaxiality and strain rate for the onset of damage. 

Damage evolution 

Damage evolution defines the behaviour of material after damage initiation. 

Means that once initiation caused, it defines the rate of degradation of the 

material stiffness [27]. 

 
Figure 5.4. Stress-strain curve under progressive damage degradation 

[22]. 

 

The above (figure 5.4), describe the stress-strain behaviour of a material 

under damage.  
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Figure 5.4 illustrates the characteristic stress-strain behavior of a material 

undergoing damage. In the context of an elastic-plastic material with 

isotropic hardening, the damage manifests itself in two forms: softening of 

the yield stress and degradation of the elasticity. The solid curve in the 

Figure 5.4 represents the damaged stress-strain response, while the dashed 

curve is the response in the absence of damage [17].  

 

Figure 5.4: Stress-strain curve with progressive damage degradation [17] . 

In the Figure 5.4  and are the yield stress and equivalent plastic strain 

at the onset of damage, and  is the equivalent plastic strain at failure; that 

is, when the overall damage variable reaches the value . The overall 

damage variable, D, captures the combined effect of all active damage 

mechanisms and is computed in terms of the individual damage variables 

[17]. 
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Where, 

E = Young’s Modulus 

D = Damage variable 

   = Yield Stress when damage onset occurs (at D=0) 

  
  

= Equivalent Plastic strain at damage onset (at D=0) 

  
  

= Plastic strain when failure occurs (at D=1). 

 

5.3 Numerical Results and Discussion 

By using the equation(5.1) and(figure 5.1), the values with in the elastic 

limit helps to calculate Young’s Modulus. 

For Aluminum: 

                               

Poisons ratio (v) = 0.3,  

Thickness (t) =9microns 

Similarly the young’s modulus calculated for LDPE is: [1] 

            

 

5.3.1 Aluminium Foil (No crack) 

To calculate the materials properties experimental results were used 

(Appendix A). Based on result plasticity values (5.4) were calculated 

analytically. The results obtained from both numerical and experimental 

calculation are almost same. The response of experimental and numerical 

results is as shown in figure (5.5). This help us to conclude that the 

aluminium foil can be modelled in FE software ABAQUS. The modelling 

techniques are given in Appendix B. 
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Plasticity Values 

Table 5.1: Yield Stress and Plastic Strain of Aluminium foil. 

No.s Yield Stress Plastic Strain 

1 36.19 0 

2 42.54 0.0001096 

3 45.12 0.000211 

4 48.13 0.0003004 

5 51.16 0.0004633 

6 54.11 0.0007017 

7 57.38 0.001147 

8 60.35 0.00182 

9 62.95 0.003004 

10 64.77 0.004132 

11 66.56 0.005547 

12 68.58 0.007468 

13 70.63 0.009318 

14 72.12 0.01117 

15 73 0.01246 

 

After calibrating fracture material parameters they were compared with 

experimental results when the young’s modulus 5563GPa, and above 

plasticity values (table 5.1) were used, good results were obtained with the 

damage initiation of 0.0001 and damage evolution of 0.075mm (Table 5.2 

and 5.3). The values of stress triaxiality and strain rate remain fixed in this 

numerical simulation. 

  



 37 

Damage Initiation 

Table 5.2: The Ductile Damage Initiation values for aluminium. 

Fracture Strain Stress Triaxiality Strain Rate 

0.0001 -5 0 

0.0001 5 0 

Damage Evolution 

Table 5.3: The damage evolution values for aluminium. 

Displacement at 

Failure 

0.075 
 

 

Figure 5.5. Force Vs. Displacement graph of Aluminium foil (No 

Crack). 
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5.3.2 LDPE 

Following are the material properties obtained from previous thesis [1]. 

Plasticity 

Table 5.4. Yield Stress and Plastic Strain of LDPE. 

No.s Yield Stress Plastic Strain 

1 5.332 0 

2 5.444 0.00134 

3 5.68 0.0022 

4 6 0.00427 

5 6.16 0.00569 

6 6.3 0.0065 

7 6.459 0.0079 

8 6.511 0.0083 

9 6.62 0.0093 

10 6.78 0.01107 

11 6.90 0.0124 

12 7.08 0.0147 

13 7.14 0.0148 

14 7.21 0.0164 

15 7.328 0.0184 

16 7.412 0.0193 

17 7.553 0.0227 

18 7.638 0.0246 

19 7.80 0.0278 

20 7.92 0.0313 

21 8.02 0.0330 

22 8.136 0.0365 
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23 8.26 0.04 

24 8.35 0.0425 

25 8.73 0.0696 

Ductile Damage 

Table 5.5. The Ductile Damage Initiation for LDPE. 

Fracture Strain Stress Triaxiality Strain Rate 

0.9 -5 0 

0.9 5 0 

 

Damage Evolution 

Table 5.6. The damage evolution for LDPE. 

Displacement at 

Failure 

0.9 

 

5.3.3 Aluminium Foil (5mm Crack) 

All the fracture material parameters like young’s modulus, plasticity, 

damage initiation and damage evolution as mentioned in section 5.3.1 

remained same for the specimen with crack length of 5mm.  

By comparing the experimental and numerical results (figure 5.6), it is seen 

that the material behaviour in both cases is different. The material 

behaviour is same for both tests with in the elastic limit is similar, but 

shows bit different behaviour in the plastic region. The results can be said 

as satisfactory. 
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Figure 5.6. Force Vs. Displacement of Aluminium foil with 5mm Crack. 

 

5.3.4 Aluminium Foil/LDPE Laminated (No Crack) 

All the fracture material parameters like young’s modulus, plasticity, 

damage initiation and damage evolution for both aluminium foil and LDPE 

as mentioned in section 5.3.1 and 5.3.2 respectively were used to simulate 

ABAQUS model. For numerical analysis of aluminium foil/LDPE in 

ABAQUS, tie constraints were introduced and the procedure is given in 

Appendix B. By comparing the experimental and numerical results (figure 

5.6), it is seen that the material behaviour in both cases are different to 

some extent, and called as satisfactory results. 
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Figure 5.7. Force Vs. Displacement of Aluminium-foil/LDPE without 

Crack. 

 

When the experimental and numerical results for Al foil, Al/LDPE was 

compared (figure 5.8), it was noticed that the experimental result for Al foil 

and numerical result for Al foil/LDPE showed almost behaviour till peak 

and changed afterwards because of LDPE. But the results for material that 

was laminated in BTH Lab was different from both discussed above, that 

may be change in material properties because of contact with PET and hot 

surface. 

While comparing the experimental results for Al foil/LDPE with no and 

full adhesion (figure 5.9) it was observed that they show same behaviour 

till peak and changed behaviour afterwards because during full adhesion the 

material behaved as a different material with new material parameters this 

is because of strong adhesive bonding between materials. 
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Figure 5.8. Comparison of Experimental and Numerical Analysis.  

 

Figure 5.9. Comparison of Experimental Results b/w Al foil/LDPE and 

Al/Adh/LDPE. 
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6 Results and Discussion 

 Due to the material degradation ABAQUS/Explicit was used. 

 Due to small thickness shell element was used. 

 True stress and true strain were taken in account to compensate the 

change in cross sectional area. 

 Due to the limitation in ABAQUS, shell element cannot be used for 

the XFEM to get mesh independent solution. 

 The results are quiet good and satisfactory in all cases of modelling 

techniques used for materials. 

 When modelling fracture material symmetry was used to get rid of 

high number of elements and time consumption. 

 For the extraction of Force/Displacement, the force was multiplied 

by 2 to get the total force for that symmetric material. 

 Physical and numerical test result of Al-foil/LDPE shown in figure 

5.7, the master surface is Aluminium foil and LDPE is slave 

surface. Tie constraints were used for contact of both materials and 

both materials were meshed individually. 

 While performing peel and shear test, the results were not 

satisfactory because of change in material properties due to hot 

surface. 

 Experimental results show that the shear force is much greater than 

the peel force. 

 For aluminium foil the theoretical result using LEFM and modified 

strip yield model was showing a close relation with the obtained 

experimental result shown in figure 3.4. 

 The fracture toughness KC obtained for the aluminium foil with 

thickness 9microns is 6.39 MPam
1/2

 and compared with previous 

work, the fracture toughness KC = 6.1 MPam
1/2

 was obtained for the 

aluminium foil for thickness of 6.25 microns [13]. This shows that 

the fracture toughness decreases with the decrease of thickness. 
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 The material properties for both Aluminium and LDPE will remain 

same in all directions, so both materials can be called as isotropic 

material. 

 In the case of Aluminium-foil/LDPE (without adhesion) both 

materials retain their properties, so that aluminium foil breaks first 

and then LDPE breaks later because it is ductile than al-foil. 

 While performing experiments for Aluminium-foil/Adh/LDPE (full 

adhesion) the failure occur at same force and displacement in both 

materials. Because of strong adhesive bonding between the 

materials, it act as one material, which help us to conclude that the 

strong adhesion change the materials parameters. 
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7 Conclusion and Future work 

In this thesis different material properties were determined by developing 

physical test and FE modelling procedure. The experimental work was 

done on aluminium foil, al-foil laminated LDPE of with and without 

adhesion. Material parameters were calibrated to use in the numerical test 

study. The tests were done only in one direction that is machine direction 

because both materials are isotropic and their properties do not change with 

the direction. The experimental and numerical tests were done for mode I 

tensile loading. The tests were conducted on the specimen size of 

95*230mm. 

Design of experiment technique was used to obtain the values of young’s 

modulus, plasticity, damage initiation and damage evolution of the 

material. 

By using theory of Linear Elastic Fracture Mechanics (LEFM), Modified 

Strip Yield model and experimental results Fracture toughness was 

calculated. These are compared for the aluminium foil and presented 

together. 

For the case of laminated Al-foil/LDPE (without adhesion), the behaviour 

of material in the numerical and physical tests is dynamic along the 

displacement and there may be number of reasons because aluminium foil 

and LDPE were laminated by a lamination machine available in BTH 

laboratory and both materials were in contact with PET to avoid the 

burning and sticking of materials with paper. This may cause the change in 

material properties. 

During the specimen preparation of aluminium foil, pre cracks may occur 

during cutting which affect the experimental results which may further 

affect the numerical results. So it is recommended that the specimen of 

aluminium foil should be preparing by water jet cutting or the cutting 

process available in TetraPak packaging companies. 

In the future this thesis can be continued to calculate the fracture toughness 

value of laminated materials. And the FE modelling strategy can be defined 

for the materials having full adhesion. Delaminating of bonded materials 

can be defined and studied under the microscope. Study of adhesives and 

their effect on the bonded material properties can be studied. 
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Proper way can be defined to laminate the material without changing their 

properties for performing peel and shear test. Also numerical modelling 

procedure can be defined for peel and shear test. 

Mesh dependency and analysis time can be calculated for the aluminium 

foil and laminated materials. 
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Appendix 

8.6 Appendix A: Experimental Results For 

Aluminium foil 
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Experimental Results Aluminium foil/LDPE 

 

 



 53 

 

 

 

  



 54 

Experimental Results Aluminium foil/Adh/LDPE 
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8.7 Appendix B: Numerical Test Results 

 Units 

Mass g 

Length mm 

Time ms 

Force N 

Stress N/mm
2
 

Density g/mm
3
 

 

 Modelling of tensile test in ABAQUS without Crack 

Following are the steps to model an Aluminium foil with no crack in 

Abaqus; 

1. Part 

 Part creation; 3D, Deformable, Shell, Planar 

2. Property 

 Create Material  to define material properties; Density, Elasticity 

and Plasticity 

 Create Section,  Shell, Homogeneous> Thickness 

 Assign Section > Middle surface 

 Assign Material Orientation > Global axis3 

3. Assembly 

 Instance Part, Independent 

4. Step 

 Create Step, “Dynamic, Explicit”> Time Period 

 Create Field output > Frequency (Evenly spaced time intervals), 

Interval (20) and define Output Variables; 

Stress (S), Strain (PE,PEEQ), Displacement (U),Forces (RF), States/Field 

(STATUS) 

 Create History output > Frequency (Evenly spaced time intervals), 

Interval (20) and define Output Variables; 

Displacement (U2),Forces (RF2) 
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5. Interaction  

 Tools> Reference Point (top left end of specimen) 

 Create Constraint > Coupling (select RP and Top Surface) 

6. Load 

 Create Boundary Condition>Initial, Displacement/Rotation to lock 

Reference Point 

 Create Boundary Condition> Initial, 

Symmetry/Antisymmetry/Encastre to Lock Base 

 

 Create Amplitude> Smooth step> Step time 
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 Create Boundary Condition> Dynamic explicit , 

Displacement/Rotation, Amplitude to Move RP  

 

 Create Boundary Condition> Initial, 

Symmetry/Antisymmetry/Encastre if the symmetric specimen 

modelled half. 

7. Mesh 

 Seed Part Instance or Seed Edge 

 Mesh> Controls > Tri, Free or structured 

 Mesh>Element Type > Explicit 

8. Job 

 Job > Precision > Double – analysis only 

9. Visualization 

 Reaction Force VS Displacement 

 Modelling of tensile test in ABAQUS with Crack 

Following are the steps to model an Aluminium foil with crack in Abaqus; 

1. Part 

 Part creation; 3D, Deformable, Shell, Planar 



 59 

2. Property 

 Create Material to define material properties; Density, Elasticity, 

Plasticity, Ductile damage and Damage evolution. 

 

 Create Section,  Shell, Homogeneous> Thickness 

 Assign Section > Middle surface 

 Assign Material Orientation > Global axis3 

3. Assembly 

 Instance Part, Independent 

4. Step 

 Create Step, “Dynamic, Explicit”> Time Period 

 Create Field output > Frequency (Evenly spaced time intervals), 

Interval (20) and define Output Variables; 

Stress (S), Strain (PE, PEEQ), Displacement (U), Forces (RF), States/Field 

(STATUS) 
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 Create History output > Frequency (Evenly spaced time intervals), 

Interval (20) and define Output Variables; 

Displacement (U2), Forces (RF2) 

5. Interaction  

 Tools> Reference Point (top left end of specimen) 

 Create Constraint > Coupling (select RP and Top Surface) 

 Tools> Partition > Face > Sketch (Draw required crack length and 

mesh drawing) 

 Special>Crack > Assign Seam (Select the drawn crack) 

6. Load 

 Create Boundary Condition>Initial, Displacement/Rotation to lock 

Reference Point 

 Create Boundary Condition> Initial, 

Symmetry/Antisymmetry/Encastre to Lock Base 

 Create Amplitude> Smooth step> Step time 

 Create Boundary Condition> Dynamic explicit , 

Displacement/Rotation, Amplitude to Move RP  

 Create Boundary Condition> Initial, 

Symmetry/Antisymmetry/Encastre if the symmetric specimen 

modelled half. 

7. Mesh 

 Seed Part Instance or Seed Edge 

 Mesh> Controls > Tri, Free or structured 

 Mesh>Element Type > Explicit 

8. Job 

 Job > Precision > Double – analysis only 

9. Visualization 

 Reaction Force VS Displacement 

 

 Modelling of tensile test in ABAQUS with Tie Constraint 

Following are the steps to model an Aluminium foil laminated with LDPE 

in Abaqus; 

1. Part 

 Part creation; 3D, Deformable, Shell, Planar (both parts created) 
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2. Property 

 Create Material  to define material properties; Density, Elasticity 

and Plasticity 

 Create Section,  Shell, Homogeneous> Thickness 

 Assign Section > Middle surface 

 Assign Material Orientation > Global axis3 

 All steps for both parts 

3. Assembly 

 Instance Part, Independent (both parts) 

 Translate Instance> using this feature two time to align the two 

parts together with no gap between them by measuring the distance 

from centre to centre of each part. 

(Al foil thickness = 0.00898mm and LDPE thickness = 0.027mm, so centre 

distance = 0.01799mm) 

4. Step 

 Create Step, “Dynamic, Explicit”> Time Period 

 Create Field output > Frequency (Evenly spaced time intervals), 

Interval (20) and define Output Variables; 

Stress (S), Strain (PE,PEEQ), Displacement (U),Forces (RF), States/Field 

(STATUS) 

 Create History output > Frequency (Evenly spaced time intervals), 

Interval (20) and define Output Variables; 

Displacement (U2),Forces (RF2) 

5. Interaction  

 Tools> Reference Point (top left end of specimen) 

 Create Constraint > Coupling (select RP and Top Surface) 

 Create constraint > Tie (select Al foil as master surface and LDPE 

as Slave surface) 

6. Load 

 Create Boundary Condition>Initial, Displacement/Rotation to lock 

Reference Point 

 Create Boundary Condition> Initial, 

Symmetry/Antisymmetry/Encastre to Lock Base 
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 Create Amplitude> Smooth step> Step time 

 

 Create Boundary Condition> Dynamic explicit , 

Displacement/Rotation, Amplitude to Move RP  
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 Create Boundary Condition> Initial, 

Symmetry/Antisymmetry/Encastre if the symmetric specimen 

modelled half. 

7. Mesh 

 Seed Part Instance or Seed Edge 

 Mesh> Controls > Tri, Free or structured 

 Mesh>Element Type > Explicit 

8. Job 

 Job > Precision > Double – analysis only 

9. Visualization 

 Reaction Force VS Displacement 
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